Chapter 429

Wilcoxon Signed-Rank Tests for Superiority by a Margin

Introduction

This procedure computes power and sample size for superiority by a margin tests in one-sample designs in which the one-sample $t$-test assumptions are violated and is the Wilcoxon Signed-Rank Test is used.

Paired Designs

Paired data may occur because two measurements are made on the same subject or because measurements are made on two subjects that have been matched according to other variables. Hypothesis tests on paired data can be analyzed by considering the difference between the paired items as the response. The distribution of differences is usually symmetric. In fact, the distribution must be symmetric if the individual distributions of the two items are identical. Hence, the paired $t$-test is appropriate for paired data even when the distributions of the individual items are not normal.

In paired designs, the variable of interest is the difference between two individual measurements. Although the non-inferiority hypothesis refers to the difference between two individual means, the actual values of those means are not needed. All that is needed is their difference.

The Statistical Hypotheses

Both non-inferiority and superiority tests are examples of directional (one-sided) tests and their power and sample size could be calculated using the Wilcoxon Signed-Rank Tests procedure. However, at the urging of our users, we have developed this procedure which provides the input and output options that are convenient for superiority hypotheses. This section will review the specifics of superiority testing.

Remember that in the usual $t$-test setting, the null ($H_0$) and alternative ($H_1$) hypotheses for one-sided upper-tail tests are defined as

$$H_0: \mu \leq \mu_0 \quad \text{versus} \quad H_1: \mu > \mu_0$$

Rejecting $H_0$ implies that the mean is larger than the value $\mu_0$. This test is called an upper-tail test because $H_0$ is rejected in samples in which the sample mean is larger than $\mu_0$.

The lower-tail test is

$$H_0: \mu \geq \mu_0 \quad \text{versus} \quad H_1: \mu < \mu_0$$
Superiority by a margin tests are special cases of the above directional tests. It will be convenient to adopt the following specialize notation for the discussion of these tests.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PASS Input/Output</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>μ</td>
<td>μ</td>
<td>Population mean. If the data are paired differences, this is the mean of those differences. This parameter will be estimated by the study.</td>
</tr>
<tr>
<td>μ₁</td>
<td>μ₁</td>
<td>Actual population mean at which power is calculated. This is the assumed population mean used in all calculations.</td>
</tr>
<tr>
<td>μ₀</td>
<td>μ₀</td>
<td>Non-Inferiority Mean. This is the smallest (or largest) value of the mean for which the new treatment will still be considered non-inferior to the reference.</td>
</tr>
<tr>
<td>μᵣ</td>
<td>μᵣ</td>
<td>Reference value. Usually, this is the mean of a reference population. If the data are paired differences, this is the hypothesized value of the mean difference.</td>
</tr>
<tr>
<td>Mₛ</td>
<td>SM</td>
<td>Margin of superiority. This is a tolerance value that defines the magnitude of difference that is not of practical importance. This may be thought of as the smallest difference from the reference value that is considered to be of practical significance. This value is assumed to be a positive number.</td>
</tr>
</tbody>
</table>

**Superiority by a Margin Tests**

A superiority by a margin test tests that the mean is better than that of the baseline (reference) population by more than a small superiority margin. The actual direction of the hypothesis depends on the whether higher values of the response are good or bad.

**Case 1: High Values Good**

In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that the mean is greater than the reference value by at least the margin of superiority.

Equivalent sets of the null and alternative hypotheses are:

- \( H₀: \mu ≤ μ₀ \) versus \( H₁: \mu > μ₀ \)
- \( H₀: \mu ≤ μᵣ + Mₛ \) versus \( H₁: \mu > μᵣ + Mₛ \)
- \( H₀: μ − μᵣ ≤ Mₛ \) versus \( H₁: μ − μᵣ > Mₛ \)

**Case 2: High Values Bad**

In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that the mean is less than the reference value by at least the margin of superiority.

Equivalent sets of the null and alternative hypotheses are:

- \( H₀: \mu ≥ μ₀ \) versus \( H₁: \mu < μ₀ \)
- \( H₀: \mu ≥ μᵣ − Mₛ \) versus \( H₁: \mu < μᵣ − Mₛ \)
- \( H₀: μ − μᵣ ≥ −Mₛ \) versus \( H₁: μ − μᵣ < −Mₛ \)
**Example**

A superiority test example will set the stage for the discussion of the terminology that follows. Suppose that a test is to be conducted to determine if a new cancer treatment substantially improves the mean bone density. The adjusted mean bone density (AMBD) in the population of interest is 0.002300 gm/cm with a standard deviation of 0.000300 gm/cm. Clinicians decide that if the treatment increases AMBD by more than 5% (0.000115 gm/cm), it provides a significant health benefit.

The hypothesis of interest is whether the AMBD in the treated group is greater than 0.002300 + 0.000115 = 0.002415. The statistical test will be set up so that if the null hypothesis that the AMBD is greater than or equal to 0.002415 is rejected, the conclusion will be that the new treatment is superior, at least in terms of AMBD. The value 0.000115 gm/cm is called the *margin of superiority*.

**Wilcoxon Signed-Rank Test Statistic**

The Wilcoxon signed-rank test is a popular, nonparametric substitute for the *t*-test. It assumes that the data follow a symmetric distribution. The test is computed using the following steps.

1. Subtract the hypothesized mean, \( \mu_0 \), from each data value. Rank the values according to their absolute values.
2. Compute the sum of the positive ranks \( S_p \) and the sum of the negative ranks \( S_n \). The test statistic, \( W_R \), is the minimum of \( S_p \) and \( S_n \).
3. Compute the mean and standard deviation of \( W_R \) using the formulas

\[
\mu_{W_R} = \frac{n(n+1)}{4}
\]

\[
\sigma_{W_R} = \sqrt{\frac{n(n+1)(2n+1)}{24} - \frac{\sum t^3 - \sum t}{48}}
\]

where \( t \) represents the number of times the \( i^{th} \) value occurs.
4. Compute the z-value using

\[
z_W = \frac{W_R - \mu_{W_R}}{\sigma_{W_R}}
\]

The significance of the test statistic is determined by computing the p-value using the standard normal distribution. If this p-value is less than a specified level (usually 0.05), the null hypothesis is rejected in favor of the alternative hypothesis. Otherwise, no conclusion can be reached.
Power Calculation for the Wilcoxon Signed-Rank Test

The power calculation for the Wilcoxon signed-rank test is the same as that for the one-sample \( t \)-test except that an adjustment is made to the sample size based on an assumed data distribution as described in Al-Sunduqchi and Guenther (1990). The sample size \( n' \) used in power calculations is equal to

\[
n' = n/W,
\]

where \( W \) is the Wilcoxon adjustment factor based on the assumed data distribution.

The adjustments are as follows:

<table>
<thead>
<tr>
<th>Distribution</th>
<th>( W )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uniform</td>
<td>1</td>
</tr>
<tr>
<td>Double Exponential</td>
<td>( \frac{2}{3} )</td>
</tr>
<tr>
<td>Logistic</td>
<td>( \frac{9}{\pi^2} )</td>
</tr>
<tr>
<td>Normal</td>
<td>( \frac{\pi}{3} )</td>
</tr>
</tbody>
</table>

The power is calculated as follows for a directional alternative (one-tailed test) in which \( \mu_1 > \mu_0 \).

1. Find \( t_\alpha \) such that \( 1 - T_{df}(t_\alpha) = \alpha \), where \( T_{df}(t_\alpha) \) is the area under a central-\( t \) curve to the left of \( x \) and \( df = n' - 1 \).
2. Calculate: \( X_1 = \mu_0 + t_\alpha \frac{\sigma}{\sqrt{n'}} \).
3. Calculate the noncentrality parameter: \( \lambda = \frac{\mu_1 - \mu_0}{\sigma \sqrt{n'}} \).
4. Calculate: \( t_1 = \frac{X_1 - \mu_1}{\frac{\sigma}{\sqrt{n'}}} + \lambda \).
5. Power = \( 1 - T_{df,\lambda}(t_1) \), where \( T_{df,\lambda}(x) \) is the area to the left of \( x \) under a noncentral-\( t \) curve with degrees of freedom \( df' \) and noncentrality parameter \( \lambda \).

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that will be of interest.

Solve For

This option specifies the parameter to be calculated from the values of the other parameters. Under most conditions, you would select either Power or Sample Size.

Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error level.

Select Power when you want to calculate the power.
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse. The choice here determines the direction of the superiority test.

- **Better (H1: \( \mu > \mu_0 \))**
  If higher means are Better the null hypothesis is \( H_0: \mu \leq \mu_0 \), and the alternative hypothesis is \( H_1: \mu > \mu_0 \).
  \[ \mu_0 = \mu_R + SM \]
  where \( \mu_R \) is the baseline, standard, or reference mean and \( SM \) is the margin of superiority.

- **Worse (H1: \( \mu < \mu_0 \))**
  If higher means are Worse the null hypothesis is \( H_0: \mu \geq \mu_0 \), and the alternative hypothesis is \( H_1: \mu < \mu_0 \).
  \[ \mu_0 = \mu_R - SM \]
  where \( \mu_R \) is the baseline, standard, or reference mean and \( SM \) is the margin of superiority.

Data Distribution
This option makes appropriate sample size adjustments for the Wilcoxon Signed-Rank test. Results by Al-Sunduqchi and Guenther (1990) indicate that power calculations for the Wilcoxon Signed-Rank test may be made using the standard \( t \)-test formulations with a simple adjustment to the sample size. The size of the adjustment depends upon the actual distribution of the data. They give sample size adjustment factors for four distributions. The options are as follows:

- **Uniform**
  The sample size adjustment factor, \( W \), is equal to “1”. This selection gives the same result as the one-sample \( t \)-test.

- **Double Exponential**
  The sample size adjustment factor, \( W \), is equal to “2/3”.

- **Logistic**
  The sample size adjustment factor, \( W \), is equal to “9/\( \pi^2 \)”.

- **Normal**
  The sample size adjustment factor, \( W \), is equal to “\( \pi/3 \)”.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large (infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size. In these cases, appropriate adjustments must be made.

When a finite population size is specified, the standard deviation is reduced according to the formula:

\[
\sigma_1^2 = \left(1 - \frac{n}{N}\right) \sigma^2
\]

where \( n \) is the sample size, \( N \) is the population size, \( \sigma \) is the original standard deviation, and \( \sigma_1 \) is the new standard deviation.

The quantity \( n/N \) is often called the sampling fraction. The quantity \( 1 - \frac{n}{N} \) is called the *finite population correction factor.*
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size

N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study. This value must be an integer greater than one. You may enter a list of values using the syntax 50 100 150 200 250 or 50 to 250 by 50.

Effect Size – Means

μ0 (Superiority Mean)
Enter a value (or range of values) for the superiority mean. Since higher means are better, this is the smallest value of the mean for which the new treatment will be considered superior to the reference.

Define μR as the baseline, standard, or reference mean and NIM as the margin of non-inferiority. When higher means are better, the superiority mean is calculated as μ0 = μR + SM and μ0 can be any number that satisfies μ0 < μ1. When higher means are worse, the superiority mean is calculated as μ0 = μR - SM and μ0 can be any number that satisfies μ0 > μ1.

μ1 (Actual Mean)
Enter a value (or range of values) for the actual mean at which power and sample size are calculated. Care should be taken that this value is consistent with whether higher means are better or worse. μ1 > μ0 when higher means are better. μ1 < μ0 when higher means are worse.

Effect Size – Standard Deviation

σ (Standard Deviation)
This option specifies one or more values of the standard deviation. This must be a positive value. Be sure to use the standard deviation of X and not the standard deviation of the mean (the standard error). If you are doing a paired test, this is the standard deviation of the differences.

When this value is not known, you must supply an estimate of it. PASS includes a special tool for estimating the standard deviation. This tool may be loaded by pressing the SD button. Refer to the Standard Deviation Estimator chapter for further details.
Example 1 – Power Analysis

Suppose that a test is to be conducted to determine if a new cancer treatment improves the mean bone density. The adjusted mean bone density (AMBD) in the population of interest (\(\mu_R\)) is 0.002300 gm/cm with a standard deviation of 0.000300 gm/cm. Clinicians decide that if the treatment increases AMBD by more than 5% (\(M_S = 0.000115\) gm/cm such that \(\mu_0 = \mu_R + M_S = 0.002415\)), it generates a significant health benefit. They also want to consider what would happen if the margin of superiority is set to 2.5% (0.0000575 gm/cm such that \(\mu_0 = \mu_R + M_S = 0.0023575\)).

The analysis will be a superiority test using the Wilcoxon signed-rank test assuming a Normal data distribution at the 0.025 significance level. Power is to be calculated assuming that the new treatment has 7.5% improvement on AMBD (\(\mu_1 = 0.0024725\)). Several sample sizes between 20 and 300 will be analyzed. The researchers want to achieve a power of at least 90%. All numbers have been multiplied by 10000 to make the reports and plots easier to read.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Wilcoxon Signed-Rank Tests for Superiority by a Margin procedure window by expanding Means, then One Mean, then clicking on Superiority by a Margin, and then clicking on Wilcoxon Signed-Rank Tests for Superiority by a Margin. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Higher Means Are</td>
<td>Better (H1: (\mu &gt; \mu_0))</td>
</tr>
<tr>
<td>Data Distribution</td>
<td>Normal</td>
</tr>
<tr>
<td>Population Size</td>
<td>Infinite</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>N (Sample Size)</td>
<td>20 40 60 80 100 150 200 300</td>
</tr>
<tr>
<td>(\mu_0) (Superiority Mean)</td>
<td>23.575 24.15</td>
</tr>
<tr>
<td>(\mu_1) (Actual Mean)</td>
<td>24.725</td>
</tr>
<tr>
<td>(\sigma) (Standard Deviation)</td>
<td>3</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Superiority Mean</th>
<th>Actual Mean</th>
<th>Standard Deviation</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.35274</td>
<td>20</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.64726</td>
</tr>
<tr>
<td>0.63360</td>
<td>40</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.36640</td>
</tr>
<tr>
<td>0.81170</td>
<td>60</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.18830</td>
</tr>
<tr>
<td>0.90968</td>
<td>80</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.09032</td>
</tr>
<tr>
<td>0.95888</td>
<td>100</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.04112</td>
</tr>
<tr>
<td>0.99524</td>
<td>150</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.00476</td>
</tr>
<tr>
<td>0.99951</td>
<td>200</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.00049</td>
</tr>
<tr>
<td>1.00000</td>
<td>300</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.00000</td>
</tr>
</tbody>
</table>

/report continues/
Report Definitions
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
N is the sample size, the number of subjects (or pairs) in the study.
SM is the magnitude of the margin of superiority. Since higher means are better, this value is positive and is the distance above the reference value that is required to be considered superior.
$\delta = \mu - \mu_0$ is the difference between the population mean and the reference value.
$\delta_1$ is the actual difference at which the power is computed.
$\sigma$ is the standard deviation of the response (or standard deviation of differences for paired data). It measures the variability in the population.
Alpha is the probability of rejecting the null hypothesis when it is true, which is the probability of a false positive.
Beta is the probability of accepting the null hypothesis when it is false, which is the probability of a false negative.

Summary Statements
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
N is the sample size, the number of subjects (or pairs) in the study.
$\mu_0 = \mu_R + SM$ is the superiority mean since higher means are better, where $\mu_R$ is the baseline, standard, or reference mean and SM is the margin of superiority.
$\mu_1$ is the actual value of the population mean at which power and sample size are calculated.
$\sigma$ is the standard deviation of the response (or standard deviation of differences for paired data). It measures the variability in the population.
Alpha is the probability of rejecting the null hypothesis when it is true, which is the probability of a false positive.
Beta is the probability of accepting the null hypothesis when it is false, which is the probability of a false negative.

Summary Statements
A sample size of 20 achieves 35% power to detect superiority using a one-sided Wilcoxon Signed-Rank test assuming that the actual data distribution is normal when the superiority mean is $23.575$ and the actual mean is $24.725$. The data are drawn from a single population with an estimated standard deviation of $3.0$. The significance level (alpha) of the test is $0.025$.

Chart Section
The above report shows that for $\mu_0 = 24.15$ (SM = 1.15), the sample size necessary to obtain 90% power is just over 300. However, if $\mu_0 = 23.575$ (SM = 0.575), the required sample size is about 80.
Example 2 – Finding the Sample Size

Continuing with Example 1, the researchers want to know the exact sample size for each value of SM to achieve 90% power.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Wilcoxon Signed-Rank Tests for Superiority by a Margin procedure window by expanding Means, then One Mean, then clicking on Superiority by a Margin, and then clicking on Wilcoxon Signed-Rank Tests for Superiority by a Margin. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Higher Means Are</td>
<td>Better (H1: μ &gt; μ0)</td>
</tr>
<tr>
<td>Data Distribution</td>
<td>Normal</td>
</tr>
<tr>
<td>Population Size</td>
<td>Infinite</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>μ0 (Superiority Mean)</td>
<td>23.575 24.15</td>
</tr>
<tr>
<td>μ1 (Actual Mean)</td>
<td>24.725</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>3</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Superiority Mean</th>
<th>Actual Mean</th>
<th>Standard Deviation</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90215</td>
<td>78</td>
<td>23.575</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.09785</td>
</tr>
<tr>
<td>0.90005</td>
<td>302</td>
<td>24.150</td>
<td>24.725</td>
<td>3.0</td>
<td>0.025</td>
<td>0.09995</td>
</tr>
</tbody>
</table>

This report shows the exact sample size requirement for each value of μ₀.
Example 3 – Validation

This procedure uses the same mechanics as the Wilcoxon Signed-Rank Tests for Non-Inferiority procedure. We refer the user to Example 3 of Chapter 416 for the validation.